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How to…
• Insert Charts

 Viewing and Changing 
Source Data

• Enter Chart Data

• Select the Type of Chart

 Selecting Chart Elements

• Use Format Dialog Boxes

• Format Legends

• Alter a Chart Title

• Format a Data Series

• Format Data Labels

• Format an Axis

• Format the Plot Area

• Format Text

• Format Gridlines

Chapter 7
Using Charts in a 

Presentation

You add graphs and charts to make your presentations more 
interesting and informative. With these tools, you can add 
visual information to your presentation, making it more easily 
absorbed and understood. You reach more viewers with 
complete information, as it is easier to absorb pictures than 
numbers or words.

In this chapter you will see how to insert and format charts in 
your presentation. You will insert charts from scratch or import 
them from Microsoft Excel. You will learn how to perfect them 
by entering your own data, selecting your own type of chart, 
and formatting chart components—such as titles, data series, 
x- and y-axes, plot area, text, and axis numbers.
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Work with Charts
You can create a chart or graph from scratch within PowerPoint or import one 
from Excel. In this book, graphs and charts are the same thing. When you first 
create a chart or graph in PowerPoint (and if you have Microsoft Excel 2007/ 
2010 installed), you’ll see a model chart displayed on the selected slide and the 
data creating it contained in a separate Excel window. If the data or chart comes 
from Excel 2007/2010, that application is opened and its ribbon and toolbars 
are available in a separate window, integrated with the PowerPoint ribbon 
and toolbars, to modify its own component. You can embed the chart, wherein 
the data is totally contained within PowerPoint, copy or paste the Excel chart 
as an image (it cannot be edited), or you can link the chart back to an Excel 
worksheet, where it is updated when the original worksheet is modified.

Insert Charts
When you first insert a chart, PowerPoint inserts a sample chart with a separate 
window containing an Excel worksheet. You replace the data in the worksheet with 
your own data, and it is reflected in the PowerPoint chart. You can also replace the 
chart with one of a different type, that is, a pie graph for a bar chart. A chart can contain 
data series—a group of related data points that are plotted on a chart. Each data series 
contains data points defining unique values in the series. You’ll have plenty of 
room—you don’t need to worry about running out of room for all your chart elements.

INSERT A CHART FROM WITHIN POWERPOINT

When you insert a chart using PowerPoint’s tools, you are embedding a chart; 
that is, the data defining the chart is wholly contained within PowerPoint, even 
though you use Excel to define the data. To insert a graph within PowerPoint:

 1. Click the slide that is to contain the chart or graph. Find a layout that contains the 

layout format and enough space for the chart you want.

 2. If the layout contains a chart icon, click the Insert Chart icon . Otherwise, click the 

Insert tab, and in the Illustrations group, click Chart.

 3. An Insert Chart dialog box will appear. Choose the type of chart you want, and 

click OK. A sample chart will be inserted in the Slide pane and a separate window 

containing a worksheet in Excel 2010 will open, as shown in Figure 7-1.

NOTE
In this book, charts and graphs refer to the same 

component.

NOTE
If you do not have Microsoft Excel 2007/2010 installed, 

or if you are using a chart or graph created in a previous 

version of PowerPoint, Microsoft Graph will be the 

application used to create charts. When you work with 

Microsoft Graph, a separate window opens with the 

toolbars and commands of that application.

NOTE
Here is some chart terminology: x-axis is the horizontal 

axis that normally contains the categories or types of data 

in a chart; y-axis is the vertical axis that normally contains 

the value or quantities of a chart; z-axis is the depth axis 

that is present in a three-dimensional (3-D) chart.7
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Figure 7-1: When you first insert a chart in PowerPoint, a model of a chart is displayed, with a separate Excel window containing the data for it.

PowerPoint window with 
sample chart inserted

Excel window with worksheet 
containing the sample data
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 4. Modify the chart and worksheet as needed. (See “Enter Chart Data.”)

 5. Save the Excel worksheet and then the PowerPoint presentation.

COPY AND PASTE A CHART FROM EXCEL USING SMARTTAG

Excel is primarily a data collection and analysis program; PowerPoint presents 
data and other information. You can use Microsoft Office 2010 to achieve the 
best of both worlds by using Excel to retain and manipulate the data and then 
copying the charts to PowerPoint for use in presentations. You have several 
options as to the relationship between the data in Excel and the charts in 
PowerPoint. (We recommend Microsoft Office Excel 2010 QuickSteps, published 
by McGraw-Hill, for learning about Excel.)

 1.  In Excel, first create, format, and then select the chart. 

Click Home and click Copy in the Clipboard area, or 

use one of several alternative copying techniques, such 

as right-clicking a blank area on the chart to display the 

context menu.

 2.  Open PowerPoint 2010. Find the slide you want, right-

click where you want the Excel chart inserted, and click 

one of the Paste options, as shown in Figure 7-2. You 

have these options:

• Keep Source Formatting & Embed Worksheet — 
Retains the original Excel formatting and embeds 
the chart and workbook data into the destination 
file so that both the chart and data can be changed 
independently of the source workbook.

• Use Destination Theme & Embed Workbook — 
Changes the formatting to that of the PowerPoint 
presentation, allowing the chart to be compatible 
with the rest of the presentation, and embeds the 
chart and workbook data into the destination file 
so that both the chart and data can be changed 
independently of the source workbook.

Figure 7-2: Charts are easily copied from Excel to PowerPoint, where you can link to the 
data or insert the worksheet into the destination file.

CAUTION
When you paste a chart that is linked to an Excel 

document, you must make data modifications to the 

source Excel worksheet. If the PowerPoint chart is 

open at the same time, the linked chart will be updated 

when you refresh the data. Even though data cannot 

be changed in PowerPoint, the format of the chart is 

independent, so once a chart is in PowerPoint, you can 

make changes to the appearance of the chart and they 

will be retained once the file is saved.

7
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Figure 7-3: Use the Select Data Source dialog box to change attributes of the source data, 
such as its range, labels, row-and-column orientation, and how empty and hidden cells will 
be plotted.

UICKSTEPS
VIEWING AND CHANGING 
SOURCE DATA

You can easily navigate between the data contained in 

an Excel worksheet and the chart in PowerPoint.

EDIT THE CHART DATA

To display the Excel worksheet containing the data for a 

chart so you can edit it:

 1. Click the chart to display the Chart Tools ribbon.

 2. On the Chart Tools Design tab, click Edit 

Data in the Data group. The Excel window 

will open, displaying the chart data.

EDIT THE DATA SOURCE ATTRIBUTES

To change the attributes of the data itself:

 1. Click the chart to display the Chart Tools ribbon.

 2. On the Chart Tools Design tab, click Select 

Data in the Data group. The chart data is 

displayed and the Select Data Source dialog 

box will appear, as shown in Figure 7-3.

• To change the data range included in the chart, 

either select a new range or type over the 

range in the Chart Data Range text box. (To 

manipulate the worksheet more easily, click the 

Collapse button  to minimize the dialog 

box; click it again to maximize it.)

• To switch the x- and y-axes, click the Switch 

Row/Column button. The data previously 

plotted horizontally in rows will now be plotted 

vertically in columns.

• To work with the data series entries, click Add 

to add a new series (a new legend entry), click 

Edit to edit the current data series, or click 

Remove to delete a data series.
Continued . . .

• Keep Source Formatting & Link Data — Copies the chart with its Excel formatting 
and maintains a link with the source workbook, so changes made to the data are 
updated in the PowerPoint chart as well (assuming the link isn’t broken by removing 
the workbook or deleting the data). Updates are made automatically when both source 
and destination documents are opened, unless default settings have been changed.

• Use Destination Theme & Link Data — Copies the chart and changes the 
formatting according to the PowerPoint presentation. The link with the source 
workbook is maintained, so changes made to the data are updated in the 
PowerPoint chart as well, as described in the previous bullet.

• Picture — Inserts the chart as a standalone picture. No changes to the component 
are allowed by the destination program, and no data updates are provided by Excel.

 3. You can redo this by clicking the Paste Options 
SmartTag in the lower-right corner of the chart. 

The five Paste options described in Step 2 are 

available.
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Enter Chart Data
When inserting a new chart, you will need to replace the sample data in the chart 
with your own data. Be sure to replace all the data and delete the contents of any 
leftover cells; otherwise, any remaining data will be used to generate the chart.

 1.  If the Microsoft Excel 2010 window is not open, in 

PowerPoint, click the chart to display the Chart Tools 

ribbon. Click the Design tab, and click the Edit Data 

button in the Data group. Figure 7-4 shows the Excel 

window with the datasheet automatically inserted.

 2.  To clear the current contents, highlight the area of the 

spreadsheet that you want to replace, and in the Excel 

Home tab, click the Clear down arrow in the Editing 

group, and click Clear Contents.

 3. Enter your legend titles on the leftmost column. Enter the titles of your horizontal axis 

on the top row by clicking in a cell and typing. As you make your changes, you will see 

the chart instantly change.

 4. Enter the data series points, that is, the series of data pertaining to one row or column 

on the datasheet.

Select the Type of Chart
When you insert a chart or graph, you are asked what type of chart you want to 
create. You can select the type of chart you want to create from several options, 
depending on your data and how you want it displayed, and you can change 
this later if need be.

 1. Click the chart to display the Chart Tools ribbon. On the Design tab, click the Change 
Chart Type button in the Type group.

NOTE
The new terms for axes are more “horizontal” and “vertical” 

and less x/y or value/category. Excel determines which 

axis is x and which is y based on which is greater (the 

greater one becomes the “horizontal/x/category” axis). 

Click Switch Row/Column in the Select Data Source 

dialog box (see Figure 7-3) to change this, if necessary.

TIP
The intersection between a horizontal row and a vertical 

column is a cell. You can identify it by the column and row 

letter/number designation for all charts, such as A1, or 

by the column and row labels for a particular chart, for 

example, Technical 2010.

UICKSTEPS
VIEWING AND CHANGING 
SOURCE DATA (Continued)

• To rearrange the legend entries, click the Move 

Up or Move Down arrow.

• To edit the range of cells included in 

the category axis labels, click Edit.

• To establish how empty cells will 

be plotted and whether the data 

contained in hidden rows and 

columns will be plotted as well, click 

Hidden And Empty Cells.

 3. Click OK.

7
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Figure 7-4: Within Excel, sample data is created. You must overwrite that data with your own.

Click here to 
select all the data 
in the worksheet

Replace this row 
with the names in 

the horizontal axis

Replace with your 
own data points

New chart as 
displayed in Excel

Chart copied and 
formatted in PowerPoint

Replace this column with legend 
names for each data series
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  –Or–

• Right-click in a background area of the chart, and choose Change Chart 
Type. (If you don’t see that option in the context menu, right-click in a 
different spot on the chart.) The Change Chart Type dialog box displays a 
menu of chart type options, as shown in Figure 7-5.

 2. Click a chart type on the left of the menu. You will see the variations available for 

that type.

 3. Choose the variation you want by clicking it. Then click OK.

Format Charts
Formatting is used to change color, contents, text font and size, chart lines, and 
plot area. The formatting options vary, depending on the type of chart. This 
chapter primarily discusses formatting for bar and column charts. Other chart 
types are similar, but not exactly the same as what is discussed here.

Figure 7-5: You can choose from among many different chart types and 
variations among each type.

UICKSTEPS
SELECTING CHART ELEMENTS

Depending on the type of changes to be made, there are 

several ways to select the chart element you want. Either:

• Click the element. In some cases, you may have to 

click more than once to get a single element out of 

a group. For instance, click the first time to select 

all elements of a certain type, such as the data 

series (columns in a bar chart, for instance). Click 

a second time to select only a single element, 

such as a single column.

Continued . . .

Select a data series with a single click

Second click selects a single data point

7
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Most formatting is available:

• From the Chart Tools Format tab

 –Or–

• By choosing the More element Options menu, listed in the menus of the layout 

commands in the Labels, Axes, and Background groups found on the Chart Tools 

Layout tab (for example, click Chart Title in the Labels group, and select More Title 
Options).

Use Format Dialog Boxes
When you right-click an element, the context menu will contain two types of 
options. First, you’ll see a Format element option, which contains options unique 
to an element. This displays the same dialog box as when you choose More 
element Options on the menus of commands on the Chart Tools Layout and 
Format tabs. These unique options are described in the appropriate “Format 
element” sections.

Here we discuss the second type. This option type is common to the elements 
it modifies, since, for the most part, for a certain type of element, these options 
are similar. In other words, you have the same options for modifying lines—
whether they are on the plot area, gridlines, or legend—as you do for text, 
whether the text is in the legend, the labels, the title, or the axes. See Table 7-1 as 
a reference. Figure 7-6 shows the dialog boxes referenced in the table.

To use the common formatting options:

 1. To display the Format elements dialog box, right-click the element and choose the 

Format element option.

• Click element Options (if available) to set unique element options. (For example, 
for chart legends, Legend Options offers two unique options: where to position the 
element on the chart and whether the legend can overlay the chart. The following 
sections explore these options.)

• Click an option as described in Table 7-1 and displayed in Figure 7-6. These are the 
common options shared by many of the chart elements.

 2. Click OK to close the Format elements dialog box.

NOTE
To see a selection of built-in “designer” charts, click the 

Design tab on the Chart Tools ribbon, and then click 

the Chart Styles More button in the Chart Styles group 

(if you are viewing a less than full-size screen, a Quick 

Styles button will be present, not the thumbnails of the 

styles themselves). A menu of specially formatted charts 

will be displayed for the current chart type that you can 

use to add some excitement to your presentation.

UICKSTEPS
SELECTING CHART ELEMENTS 
(Continued)

 –Or–

• Click the Chart Tools Format tab, and from the 

Current Selection group, click the Chart Elements 

down arrow. From the menu of elements, click 

the one you want. (When you use this approach, 

you then select the changes you want by clicking 

Format Selection from the Current Selection 

group to open the Format 

element dialog box for 

formatting choices.)

TIP
The element displayed in the Chart Elements button on 

the Chart Tools Format tab changes as you select an 

element on the chart. For example, when you select a 

column, the option will be Series name; when you select 

an axis, the option will be named Axis; when you select 

the legend, the option will be Legend.
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FORMATTING 
OPTIONS DESCRIPTION APPLY TO

Fill Provides options for gradient, picture, or texture/pattern fill, as well as 
color choices and degrees of transparency. Each option displays unique 
content in the dialog box.

Axis, chart area, data labels/series, legend, 
plot area, titles, walls/floors

Border Color Offers solid or gradient lines, as well as color choices, degrees of 
transparency, and gradient options. Choose No Line, Solid Line, and 
Gradient Line (or the default Automatic.)

Axis, chart area, data labels/series, error bars, 
gridlines, legend, plot area, titles, trendlines, 
walls/floors

Border Styles Provides options for changing width, dashed, and compound (multiple) 
lines, as well as styles for line ends and line joins (and Rounded 
Corners for Chart Area)

Axis, chart area, data labels/series, error bars, 
gridlines, legend, plot area, titles, trendlines, 
walls/floors

Shadow Provides preset shadow styles and controls for color, transparency, size, 
blur, angle, and distance

Axis, chart area, data labels/series, legend, 
plot area, titles, trendlines, walls/floors

3-D Format Adds 3-D effect to shapes; provides top, bottom, material, and lighting 
presets and controls for depth contours and color. For instance, you can 
format the element with a bevel effect, changing the shape, depth, color, 
contours, and surface material and lighting.

Axis, chart area, data labels/series, legend, 
plot area, titles, walls/floors

3-D Rotation Changes the rotation of the chart, whether the text is rotated or flat, the 
object’s position from the ground of the chart, and the chart scale for 
a chart wall or floor (its depth and height as a percentage of the base 
or whether it is automatically scaled). Provides angular rotation and 
perspective adjustments, as well as positioning and scaling controls. 

Walls/floors

Number Provides the same number formats as the Format Cells Number tab, 
such as for currency, accounting, dates and time, percentages, fractions, 
etc. Also, you can establish whether the number is linked to a source 
worksheet.

Axis, data labels

Alignment (Sometimes called Text Box.) Changes the text layout: vertically aligns, 
rotates, and stacks text; determines whether AutoFit should be applied 
to the text (the text box resized for the text or the text resized for the text 
box); and what the internal margins are within the text box. 

Axis, data labels, titles, legends

Glow and Soft 
Edges

Adds glow or soft-edged effects; varying color; and size, transparency, 
and degree of emphasis

Titles, legends, data labels, chart area, plot 
area, series/labels, walls/floors, axis

Table 7-1: Formatting Options for Chart Elements
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Figure 7-6: The Format dialog boxes for common options are shown here.

Number Formatting Fill Formatting Border Color 
Formatting

Border Styles Formatting Shadow Formatting

Alignment Formatting3-D Rotation Formatting3-D FormattingGlow and Soft Edges Formatting
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Format Legends
 1. After selecting the chart, click the Chart Tools Layout tab, and click Legend. A menu 

will open, as shown in Figure 7-7.

 2. Click one of the options to hide the legend or position it on the chart.

  –Or–

  Click More Legend Options to open the Format Legend dialog box. Under Legend 

Options, you can establish where on the chart the legend will be placed and whether it 

will be permitted to overlay the chart itself. See “Use Format Dialog Boxes,” Table 7-1, 

and Figure 7-6 for detailed information on other formatting options.

Alter a Chart Title
To change the title of a chart:

After selecting the chart, right-click its title and select Format Chart Title. The Format Chart 

Title dialog box appears. See “Use Format Dialog Boxes,” Table 7-1, and Figure 7-6 for detailed 

information on the formatting options. Click Close to exit the Format Chart Title dialog box.

–Or–

Click the chart to display the Chart Tools tabs, click the 

Layout tab, and click Chart Title in the Labels group. From 

the menu, click one of these options:

• Click None to hide the chart title.

• Click Centered Overlay Title to center the title on the 

chart and to overlay contents, if needed.

• Click Above Chart to display the title at the top of 

the chart and to avoid overlaying the contents by 

reducing the size of the chart.

• Click More Title Options to open the Format Chart Title dialog box. See “Use Format 

Dialog Boxes,” Table 7-1, and Figure 7-6 for detailed information on other formatting 

options. Click OK to close the Format Chart Title dialog box.

–Or–

To just change the title contents and the text attributes, highlight the title to select it, type over 

the title, click the Home tab, and use the tools in the Font group. However, if you are changing 

a linked chart, you’ll have to make any revisions to the source data in the Excel worksheet.

NOTE
The options on the Format elements dialog box will 

vary, depending on the type of chart. For instance, a 

pie chart will have different options than a bar chart. In 

addition, the attributes within an option will be different. 

For example, the Fill attributes for a pie chart are different 

from those for a bar chart.

Figure 7-7: You can modify the 
legend of a chart by changing 
its position on the chart or by 
formatting its lines and text.
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Format a Data Series
To format a data series for a bar chart:

 1. Click the chart to display the Chart Tools tabs. Click the Layout tab.

 2. Click the Chart Elements down arrow in the Current Selection group (it will have the 

name of the last element selected) to see a list of elements on the chart. Click the data 

series you want to change. The element will be selected, as you can verify on the chart.

 3.  Click Format Selection in the Current Selection group. The Format Data Series dialog 

box appears.

 4. Select from these options:

• In Series Options, drag the Gap Depth slider to set the distance 
the data series is from the front of the chart (only available for 
3-D charts).

• In Series Options, drag the Gap Width slider to set the width of 
the gap between sets of data series, adjusting the width of each 
series element accordingly, as shown in Figure 7-8.

 5.  See “Use Format Dialog Boxes,” Table 7-1, and Figure 7-6 for 

detailed information on other formatting options.

 6. Click Close to exit the dialog box.

Format Data Labels
To format the data labels:

 1.  Click the chart to display the Chart 

Tools tabs. Click the Layout tab.

 2.  Click Data Labels in the Labels 

group to display a menu of options.

• Click None to hide or turn off data labels. They cannot be 
selected when this option is selected.

• Click Show to show or turn on the data labels so that they can 
be selected (select specific data series first if you only want 
labels to appear on them).

Figure 7-8: The Format Data Series dialog box contains options to position 
the data series from the front of the 3-D chart and to set the width of the gap 
between sets of data series.

Gap Depth establishes 
how far back the data 

series rests on the chart

Gap Width sets the width of the gap 
between sets of data series, adjusting the 

width of the data series to compensate

7
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 3. Click More Data Labels Options for additional formatting options. In the Label 

Options category, select from among the following:

• Series Name indicates that the label will contain the name of the data series.

• Category Name includes the category in the label.

• Value includes the value in the label. Value is the default label content.

• Show Leader Lines enables a line connecting data labels 
to the relevant element in the chart. (This option is available 
when you have added data labels to an appropriate chart, 
such as a pie chart.)

• Reset Label Text restores the default of Value only.

• Include Legend Key In Label places the key (identifying 
color, for example) in the label.

• Separator indicates how multiple elements in the label will 
be separated. A comma is the default.

 4. See “Use Format Dialog Boxes,” Table 7-1, and Figure 7-6 for 

detailed information on other formatting options.

 5. Click Close to close the dialog box.

 Format an Axis
To format an axis for a chart and define the maximum, minimum, and 
incremental values; set tick marks; positioning; and more: 

 1. Click the chart to display the Chart Tools tabs. Click the Layout tab.

 2. Click Axes in the Axes group to display a menu of options. Select Primary Horizontal 
Axis (the x-axis), Primary Vertical Axis (the y-axis), and, when available, Depth Axis 

(the z-axis). With the Primary Horizontal Axis option of a column chart, you have the 

following choices:

• Click None to hide or turn off the axis.

• Click Show Left To Right Axis to display vertical labels on the left edge of the chart 
and to start the category axis on the left.

• Click Show Axis Without Labeling to suppress the labels and tick marks.

• Click Show Right To Left Axis to display vertical labels on the right edge of the 
chart and to start the category axis on the right.

TIP
Showing leader lines in a pie chart connects the chart to 

data labels, which identify the data being viewed. To add 

leader lines, right-click the “pie” elements on the chart, 

and click Add Data Labels. When the values appear on 

the pie chart, click them and drag them where you want 

them outside of the chart (they need to be sufficiently far 

from the chart to appear—you may need to move them 

around a bit to find out where they appear). You’ll want to 

right-click the chart and select Format Data Labels, to 

make sure that Show Leader Lines is selected. 

7
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 3.  If you click More Primary Horizontal Axis Options, you’ll see a dialog box 

of additional formatting options. (Step 4 explains the More Primary Vertical 

Axis Options menu.) These options are shown in Figure 7-9. In the Axis 

Options category, you have the following options:

• Interval Between Tick Marks sets the number of units between tick marks.

• Interval Between Labels can be set in two ways. Select Automatic to have 
PowerPoint determine the interval between labels; click Specify Interval 
Unit, and then type a number if you want to refine the interval.

• Categories In Reverse Order displays the x-axis categories in reverse, from 
right to left.

• Label Distance From Axis sets how many units are between the label and 
the axis.

• Axis Type determines whether the axis is numeric, dates, or text. Select 
Automatically Select Based On Data, Text Axis, and Date Axis.

• Major Tick Mark Type and Minor Tick Mark Type determine whether the tick 
marks are inside the axis, outside the axis, or positioned across it.

• Axis Labels indicates where the labels are in relation to the axis: Next To 
Axis places them adjacent to the axis; High places them on the top of the 
chart; Low places them beneath the axis; None causes no labels to be 
displayed.

• Vertical Axis Crosses establishes where the y-axis will intersect with the 
x-axis. Normally, they cross at the left or right end of the horizontal axis. You 
can have them cross somewhere within the middle of the plot area, based 
the choices offered. Select Automatic to let PowerPoint determine the 
crossover, select At Category Number to manually set the crossover, or 
select At Maximum Category to establish the point on the y-axis where the 
largest value will cross the x-axis.

 4. Click Primary Vertical Axis to see a menu to display the axis (or not), or 

to choose units for the vertical (y) axis. You can also choose to display the 

Figure 7-9: The Format Axis dialog box is used to define the attributes 
of a selected axis. This example shows the options for the horizontal 
axis (the category axis) of a column type chart.
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axis using a logarithmic 10 scale. If you click More Primary Vertical Axis 
Options at the bottom of the Primary Vertical Axis menu, you’ll see a 

different dialog box with additional formatting options, shown in Figure 7-10. 

You have the following choices:

• Minimum changes the lowest value automatically; or you can type a fixed 
value in the text box.

• Maximum changes the highest value automatically; or you can type a 
fixed value in the text box.

• Major Unit shows the largest increments displayed automatically; or you 
can type a value in the text box.

• Minor Unit shows the smallest increments displayed automatically; or you 
can type a value in the text box.

• Values In Reverse Order displays the largest value at the bottom of the 
axis and the smallest at the top.

• Logarithmic Scale displays the values in a logarithmic relationship rather 
than in an arithmetic one.

• Display Units shows a menu of units that can 
be displayed. If you select a quantity, you can 
select Show Display Units Label On Chart.

• Major Tick Mark Type and Minor Tick Mark 
Type determine whether the tick marks are 
inside the axis, outside the axis, or positioned 
across it.

• Axis Labels indicates where the labels are in 
relation to the axis. Next To Axis places them adjacent to the axis; High 
places them on the top of the chart; Low places them beneath the axis; 
None causes no labels to be displayed.

• Floor Crosses At establishes the point or value on the vertical axis where 
the horizontal axis will cross it. Select Automatic to have PowerPoint 
determine this, select Axis Value to set the value yourself, or select 
Maximum Axis Value to establish the point on the horizontal axis where 
the largest value will cross the vertical axis.

 5. Click Close to close the dialog box.

Figure 7-10: The Vertical Axis Format Axis dialog box defines the 
attributes of the y-axis.7
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Format the Plot Area
The chart area encompasses the total chart area, whereas the plot area is a 
subset of the total chart area. The plot area is the background upon which the 
chart rests. It can be formatted with color and fill effects, and its border can be 
formatted to take on a different style, thickness, or color.

 1. Click the chart to display the Chart Tools tabs. Click the Layout tab.

 2. Click the Chart Elements down arrow in the Current Selection group, and click Plot 
Area. Then click Format Selection in the Current Selection group. The Format Plot 

Area dialog box appears.

 3. See “Use Format Dialog Boxes,” Table 7-1, and Figure 7-6 for detailed information on 

the formatting options.

 4. Click Close to close the dialog box.

Format Text
You can format text in a chart by changing its font, font style, font size, and 
color. If you are changing data in a linked file from Excel, for example, you must 
make the changes in the source worksheet. However, text in a label is changed 
in PowerPoint.

 1. Select the chart element that contains the text to be formatted.

 2. Click the Home tab, select the text to be changed, and use any of the tools in the Font 

group.

  –Or–

  Use the options on the mini toolbar that floats over selected text.

Format Gridlines
To make gridlines less obvious or more apparent (usually in order to help 
viewers visually):

 1. Click the chart to display the Chart Tools tabs.

 2. Click the Layout tab, and click Gridlines in the Axes group. A menu is displayed.
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 3. Choose from among these options:

• Primary Horizontal Gridlines displays or hides major and minor horizontal 
(or x-axis) gridlines.

• Primary Vertical Gridlines displays or hides the major and minor vertical 
(or y-axis) gridlines.

• Depth Gridlines (only for some chart types, such as Surface) shows or hides the 
major depth and minor depth (or z-axis) gridlines.

 4. For any of the gridlines, click More type Gridlines Options to display the Format 

Gridlines dialog box, where you can change the line and line styles. (See “Format 

Dialog Boxes,” Table 7-1, and Figure 7-6 for detailed information on the options.)

 5. Click Close when you have made your choices.
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